
NO COMPUTER CLUB MEETING THIS FRIDAY, 5/ 
24/12 due to the holiday. 
******************************************************************
******************************** 

YouTube videos won't play?  

Videos on YouTube are streamed through Adobe Flash player. If you're having trouble playing 

videos on YouTube, we suggest you install the latest version of the Flash player. 

Note, if you're seeing the "You need to upgrade your Adobe Flash Player to watch this video" 

error, you've come to the right place. 

 

Follow these steps to upgrade to the most recent version of Adobe's Flash Player:  

1. Before installing Adobe Flash, you will need to first uninstall any older versions you 

currently have running on your computer. To do so, download Adobe's official 

uninstaller here. Make sure to select your correct operating system, and then "Uninstall 

Flash." 

2. Now that you've uninstalled the older version of Flash, follow Adobe's instructions for 

reinstalling the most recent version. The download option is on the right-hand side of the 

page. 

3. Once you've downloaded the file, please exit your browser first, and then install the 

upgraded version of Flash to you're computer. 

4. Finally, open your browser again and go to YouTube. You should now be able so 

successfully watch videos! 

If the instructions above don't resolve the issue, please also try the following:  

1. Temporarily disable popup blocking software installed on your computer to test. 

2. Allow YouTube.com as a trusted site in your Firewall software. 

3. Ensure other applications like Quicktime, iTunes, Real Player, or Windows Media 

Player aren't set as the default streaming application, as this might affect the video 

player. 

4. Make sure your computer is set up properly for Flash by checking out Adobe's Advanced 

Troubleshooter here. 

If you continue having difficulty viewing videos...  

• Troubleshoot the issue here. 

• Check our Current Site Issues page to see if the situation's due to a known bug.  

• You can also visit the Community Help Forums and discuss your issue with other users 

there. 
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****************************************************************************************************
**  
Videos Downloaded to Your Computer 
 
1. Go to Youtube.com and locate the Video that you wish to copy to your computer. 
2. Highlight and copy the URL link for that video's location. 
2. Open new browser window. Go to www.SAVETUBE.com 
3. Paste the URL into the box and click GO. Be patient, it takes time for the Download 
button to appear and give you the choice of formats. 
4.Click Download and save the Video to whichever folder you choose on your hard 
drive. 
Note: I selected MP4 and used QuickTime to play it. 
 
You may also download the free FLV player and the AVS converter at the 
Savetube.com site. 

3GP is the video format for your phone, if ever you wish to play it there. 
FLV is a Flash format, you can play it on your PC with Winamp. (Free) 
MP4 is a format for your PC and Phone, you can play it with QuickTime. (Free)  

****************************************************************************************************
**** 

 

Q. Why is my streaming video jerky and not 'streaming'? 

A. I'll try to answer your question about the video buffering and congestion. The Real Player 

receives the video from the Internet via your modem and the video is initially placed into what is 

called a buffer that is used to temporarily store the video data before you can view it. At a certain 

point the buffer releases the video so that you can view it. 

At the same time, more video is received and enters the buffer to help keep a smooth stream of 

video flowing. Without the buffer, the video would be choppy and there would be times where 

the video stops completely while it waits for the video data to transfer from the Internet to your 

PC. Even with the buffer this can happen because we use slow dial-up telephone lines to connect 

to the Internet. The message about Net congestion was to tell you that the Internet lines were 

clogged up with lots of activity and this was slowing down the flow of the video data to your PC. 

This can happen during the busy times of the day when lots of people are on the Internet. The 

congestion is usually at its worst during the middle of the morning, middle of the afternoon, and 

during the evening. If you try viewing the video at 3am I can pretty much guarantee that you will 

get 

pretty good performance. Most people don't think it's worth it to get on at that time, however. 
 
 



*********************************************************************************************

****** 

Video Sounds Enabled 

 
Q. I no longer get sound with Videos on the internet. I used to get sound and I get 
sound on CDs, etc. so my sound card is ok. 
A. This is usually a problem with Adobe Flash Player Settings.  
Try this: 
1. Go online and locate a video such as at www.youtube.com 
2. Select a video and click to start it, then rightclick on the video itself 
3. Click Settings. 
4. Click Advanced to go to Settings Manager 
5. Click on the 2nd item - Global Storage Setting Panel. 
5. Put a check to allow 3rd party....if that box is not checked, you'll get the video but no 
sound. Both boxes should be checked. 
6. Also, move the slider to the right to 1MB to avoid pauses in the streaming of the 
video. 
 
NOTE: It could be a CODEC that's needed.  
Download the sound utility from kcsoftware.com. 
Run the video inspector while running a video. It will tell you if it needs a new codec and 
where to get it. 
****************************************************************************************************
********************** 
 
Connect to an Available Wireless Network 

When you connect your computer to a network by using an Ethernet cable, Win 7 

automatically creates the network connection. To connect to a wireless network for the first 

time, YOU need to make the connection. 

Connect to an Available Wireless Network 

1. In the notification area look for either a single monitor screen or a stack of reeds toy. 

This will be the icon for the wireless connection. Click that icon to open the wireless 

network box where there will be a list of wireless networks that are available. If the 

network says Secured, it means you must enter a wep or wpa code before you can connect. 

2. There may also be a box to click to show Available Wireless Networks. you should 

recognize your own wireless network since you set it up. 

3. Click the wireless network to which you wish to connect, then click the Connect button. 

If necessary enter the WEP or WPA password.  

4. In Win 7 each network profile includes these settings: 

 a. Network discovery - can the computer see and be seen by other computers 

connected to the same network. 



 b. File and printer sharing - shows if network users can access files and printers you 

have shared. 

 c. Public folder sharing - shows if network users can access files stored in the Public 

folders in your computer. 

 d. Media streaming - shows if network users can access music, videos and pictures 

stored in your media library. 

 e. File sharing - shows the security requirements for devices that connect to your 

computer's file sharing connections. 

 f. Password-protected sharing - shows if files are available to any network user or 

only to users with user accounts in your computer. 

 g. HomeGroup connections - shows if only those with User Accounts can be joined 

to your homegroup.  

Note: Network connection types and homegroups may not be available on a computer 

running an earlier version of Windows. 

****************************************************************************************************
*************************************************** 

Changing Web page fonts and background colors 

When Web authors and designers create Web pages, they often specify particular type (font) 

faces, colors, sizes, and background colors. These settings are specified for each item, or in a 

"style sheet", which is a type of template for specifying how different styles should appear 

throughout a Web page or site. 

You can override any or all of these settings, which is useful if you have limited or low vision. 

You can specify your font and color preferences for all pages that do not use style sheets, and 

then you can specify whether to use any or all of your preferences on pages that use style sheets. 

*********************************** 

To change the appearance of the Windows toolbar 

• You can add or remove standard toolbar buttons, use smaller toolbar buttons like the ones 

used in Microsoft Office, and change the order they are displayed on the toolbar. Just 

right-click the toolbar, and then click Customize.  

• You can move or resize the Address bar and Links bar by dragging them up, down, left, 

or right. You can even move them into the menu bar!  

• You can hide the Address bar or Links bar by right-clicking the toolbar, and then clearing 

the check mark for each item you want to hide.  

• You can add items to the Links bar by dragging the icon from the Address bar or 

dragging a link from a Web page.  



• You can rearrange items on the Links bar by dragging them to a new location on the bar.  

To display Web page text larger or smaller 

• On the View menu, point to Text Size, and then click the size you want. . 

To change how Web page colors are displayed 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Colors.  

3. Change the settings as needed.  

To specify fonts and colors to always use for Web pages 

1. On the Tools menu in Internet Explorer, click Internet Options.  

2. On the General tab, click Accessibility.  

3. Change the settings as needed 

************************************************************  
Download A File To The CD-Writer  

1.First download it to the desktop or to a folder on your own hard drive. 
2.Next, locate the file you downloaded and rightclick it. 
3.Select SEND TO: and click the drive Letter which is your CD-Writer (if you have 
a cd-rom/cd-writer combo, then the letter may just say cd-rom. 
4. A message will pop up in your startup tray saying "you have files to be written 
....., click here". Click the icon. 
5. On the screen that comes up you'll see the file you selected and it will have a 
white arrow on it indicating it's a shortcut to the file. This is because the file is 
first copied to the Windows TEMP folder before being written to a cd. Click the file 
once to select it. 
6. Put a blank cd into the CD-writer tray. 
7. On the left side of the screen at the very top, click Write these files to CD. A 
page will come up then asking you to name the CD. 
8. Give the CD a name and click Next. Wait, it may take a minute before you see 
the blue line indicating it is being written. You will get a message stating Writing 
is complete when it finishes. 
9. Click Finish. 
********************************************************************************************** 
DOWNLOAD A FILE ATTACHED TO AN EMAIL  

 

1. Click the DOWNLOAD button at the bottom of the email (AOL), or click the 

paperclip(Outlook Express) 

2. The file will be downloaded to the folder that is set as your default download folder 

(AOL\Download) or (File set for default in OE) 

3. IF using AOL, the file will also pop up and you can click Open to open it.  
 



FIND A DOWNLOADED FILE  
<< I downloaded files yesterday and I am still hunting for them>> 

 

Do you know the name of the files you downloaded?  

1. Click FILE at the top of your AOL page. 

2. Select DOWNLOAD MANAGER 

3. Doubleclick the file you want to open and it should open, if not 

 

Write down the name of the file you see listed here and: 

 

1. RightClick START…SEARCH. (or click Start and just type the file name in the search box if 

using Win 7)  

2. Type the name of the file you want to find in the top NAME box. 

4. Click the down arrow of the LOOK IN box and select the C: drive 

5. Click SEARCH. 

6. The file will then be listed along with the entire path. e.g. C:\AOLxxx\DOWNLOAD\ 

(and the name of the file). You may doubleclick to open the file from here. Or go to the 

WINDOWS EXPLORER, click on the C: drive you can scroll down to the AOL folder, 

click the + sign, scroll further down to the DOWNLOAD subfolder and doubleclick it, 

you will find the file listed on the right hand side of the page along with all the other files 

that have been stored in the DOWNLOAD subfolder. 
************************************************************** 

 
I received this message today. I've not confirmed the facts but am told they are 
accurate. Sure gives us seniors something to think about. 

"The per person Medicare insurance premium will increase from the present 
monthly fee of $96.40, rising to: $104.20 in 2012; $120.20 in 2013; And 
$247.00 in 2014.These are provisions incorporated in the Obamacare 
legislation, purposely delayed so as not to 'confuse' the 2012 re-election 
campaigns. Send this to all seniors that you know, so they will know who's 
throwing them under the bus." 
******************************************************************* 

 


